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Avvertenze di legge 
Concetto di segnaletica di avvertimento 

Questo manuale contiene delle norme di sicurezza che devono essere rispettate per salvaguardare l'incolumità 
personale e per evitare danni materiali. Le indicazioni da rispettare per garantire la sicurezza personale sono 
evidenziate da un simbolo a forma di triangolo mentre quelle per evitare danni materiali non sono precedute dal 
triangolo. Gli avvisi di pericolo sono rappresentati come segue e segnalano in ordine descrescente i diversi livelli 
di rischio.  

 PERICOLO 
questo simbolo indica che la mancata osservanza delle opportune misure di sicurezza provoca la morte o gravi 
lesioni fisiche. 

 

 AVVERTENZA 
il simbolo indica che la mancata osservanza delle relative misure di sicurezza può causare la morte o gravi 
lesioni fisiche. 

 

 CAUTELA 
indica che la mancata osservanza delle relative misure di sicurezza può causare lesioni fisiche non gravi. 

 

 ATTENZIONE 
indica che la mancata osservanza delle relative misure di sicurezza può causare danni materiali. 

Nel caso in cui ci siano più livelli di rischio l'avviso di pericolo segnala sempre quello più elevato. Se in un avviso 
di pericolo si richiama l'attenzione con il triangolo sul rischio di lesioni alle persone, può anche essere 
contemporaneamente segnalato il rischio di possibili danni materiali. 

Personale qualificato 
Il prodotto/sistema oggetto di questa documentazione può essere adoperato solo da personale qualificato per il 
rispettivo compito assegnato nel rispetto della documentazione relativa al compito, specialmente delle avvertenze 
di sicurezza e delle precauzioni in essa contenute. Il personale qualificato, in virtù della sua formazione ed 
esperienza, è in grado di riconoscere i rischi legati all'impiego di questi prodotti/sistemi e di evitare possibili 
pericoli. 

Uso conforme alle prescrizioni di prodotti Siemens 
Si prega di tener presente quanto segue: 

 AVVERTENZA 
I prodotti Siemens devono essere utilizzati solo per i casi d’impiego previsti nel catalogo e nella rispettiva 
documentazione tecnica. Qualora vengano impiegati prodotti o componenti di terzi, questi devono essere 
consigliati oppure approvati da Siemens. Il funzionamento corretto e sicuro dei prodotti presuppone un trasporto, 
un magazzinaggio, un’installazione, un montaggio, una messa in servizio, un utilizzo e una manutenzione 
appropriati e a regola d’arte. Devono essere rispettate le condizioni ambientali consentite. Devono essere 
osservate le avvertenze contenute nella rispettiva documentazione. 

Marchio di prodotto 
Tutti i nomi di prodotto contrassegnati con ® sono marchi registrati della Siemens AG. Gli altri nomi di prodotto 
citati in questo manuale possono essere dei marchi il cui utilizzo da parte di terzi per i propri scopi può violare i 
diritti dei proprietari. 

Esclusione di responsabilità 
Abbiamo controllato che il contenuto di questa documentazione corrisponda all'hardware e al software descritti. 
Non potendo comunque escludere eventuali differenze, non possiamo garantire una concordanza perfetta. Il 
contenuto di questa documentazione viene tuttavia verificato periodicamente e le eventuali correzioni o modifiche 
vengono inserite nelle successive edizioni. 
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 Prefazione 1 
 

 

Marchi 
Le seguenti denominazioni o eventuali altre denominazione non contrassegnate con il 
marchio relativo alla proprietà esclusiva ® sono marchi registrati di Siemens AG: 

C-PLUG, CP 343-1, CP 443-1, SCALANCE, SIMATIC, SOFTNET 

Ambito di validità della documentazione 
Questa istruzione descrive l'approccio all'utilizzo e a tutte le proprietà più importanti dei 
seguenti dispositivi SCALANCE S:  

● SCALANCE S602, numero articolo: 6GK5602-0BA10-2AA3 

● SCALANCE S612, numero articolo: 6GK5612-0BA10-2AA3 

● SCALANCE S623, numero articolo: 6GK5623-0BA10-2AA3 

● SCALANCE S627-2M, numero articolo: 6GK5627-2BA10-2AA3 

Qui vengono descritte le possibilità di montaggio disponibili e la messa in servizio del 
dispositivo in poche operazioni. 

 

 Nota 

Le omologazioni indicate valgono come indicate solo se sul prodotto è applicato il relativo 
contrassegno.  

 

Avvertenze per la progettazione  
I dispositivi SCALANCE S riportati sopra possono essere progettati con i seguenti strumenti: 

 
Strumento di progettazione Relativa documentazione 
Security Configuration Tool (standalone e inte-
grato in STEP 7 a partire da V5.5 SP2 HF1) 

Manuale di progettazione "SIMATIC NET Industrial Ethernet Security - 
Nozioni di base e applicazione Security" Una versione attuale si trova in 
Internet alla seguente ID articolo: 56577508 
(http://support.automation.siemens.com/WW/view/it/56577508) 

STEP 7 a partire da V12 Guida in linea "Sistema informativo", sezione "Industrial Ethernet Securi-
ty" 

Le descrizioni contenute in questo manuale relative alla progettazione di dispositivi 
SCALANCE S si riferiscono al Security Configuration Tool. 

http://support.automation.siemens.com/WW/view/it/56577508
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Informazioni relative ai moduli mediali e agli SFP 
I moduli mediali e gli SFP, che possono essere utilizzati per SCALANCE S627-2M, sono 
riportati nel seguente capitolo del presente manuale del prodotto: 
Dati tecnici (Pagina 11) 

Informazioni dettagliate su questi moduli mediali e sugli SFP, quali dati tecnici, istruzioni di 
montaggio e messa in servizio, si trovano in Internet alla seguente ID articolo: 74843168 
(http://support.automation.siemens.com/WW/view/it/74843168) 

Glossario SIMATIC NET 
Descrizione dei numerosi termini specifici, presenti nella documentazione che si trovano nel 
glossario SIMATIC NET. 

Il glossario SIMATIC NET si trova: 

● SIMATIC NET Manual Collection o DVD del prodotto 

Il DVD è allegato ad alcuni prodotti SIMATIC NET. 

● In Internet alla seguente ID articolo: 

50305045 (http://support.automation.siemens.com/WW/view/it/50305045)  

Indicazioni di sicurezza 
Siemens commercializza prodotti di automazione e di azionamento per la sicurezza 
industriale che contribuiscono al funzionamento sicuro di impianti, soluzioni, macchinari, 
apparecchiature e/o reti. Questi prodotti sono componenti essenziali di una concezione 
globale di sicurezza industriale. In quest’ottica i prodotti Siemens sono sottoposti ad un 
processo continuo di sviluppo. Consigliamo pertanto di controllare regolarmente la 
disponibilità di aggiornamenti relativi ai prodotti. 

Per il funzionamento sicuro di prodotti e soluzioni Siemens è necessario adottare idonee 
misure preventive (ad es. un concetto di protezione di cella) e integrare ogni componente in 
un concetto di sicurezza industriale globale all’avanguardia. In questo senso si devono 
considerare anche gli eventuali prodotti impiegati di altri costruttori. Per ulteriori informazioni 
sulla sicurezza industriale, vedere http://www.siemens.com/industrialsecurity. 

Per restare informati sugli aggiornamenti cui vengono sottoposti i nostri prodotti, suggeriamo 
di iscriversi ad una newsletter specifica del prodotto. Per ulteriori informazioni, vedere 
http://support.automation.siemens.com. 

http://support.automation.siemens.com/WW/view/it/74843168
http://support.automation.siemens.com/WW/view/it/50305045
http://www.siemens.com/industrialsecurity
http://support.automation.siemens.com/
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 Avvertenze di sicurezza 2 
 

 

Osservanza delle avvertenze di sicurezza 
Osservare le seguenti avvertenze di sicurezza. Esse si riferiscono alla durata completa del 
dispositivo. 

Osservare inoltre le avvertenze di sicurezza relative all'utilizzo nei singoli capitoli, in 
particolare nei capitoli "Montaggio" e "Messa in servizio". 

2.1 Avvertenze generali 
La messa in servizio è vietata fino a quando viene stabilito che la macchina nella quale deve 
essere montato questo componente è conforme alle disposizioni della direttiva 89/392/CE. 

 

 ATTENZIONE 

Sostituzione della batteria 

Ciascun dispositivo SCALANCE S contiene una batteria. Questa batteria non deve essere 
sostituita né dal cliente, né dal personale di assistenza. Una sostituzione della batteria può 
essere eseguita solo dal produttore MF-K. Di conseguenza inviare il dispositivo con 
l'avvertenza "Sostituzione batteria" al seguente indirizzo: 

 

Siemens AG 

I IA SC MF-K BP51 

Repair-Center 

Östliche Rheinbrückenstr. 50 

76187 Karlsruhe, Deutschland 
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2.2 Avvertenze in caso di utilizzo in zone a rischio di esplosione 
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2.2 Avvertenze in caso di utilizzo in zone a rischio di esplosione 
 

 AVVERTENZA 

Per l'impiego in ambiente a pericolo di esplosioni secondo la Class I, Division 2 o Class I, 
Zone 2, l'apparecchio deve essere montato in un quadro elettrico o in una custodia. 

 

 

 AVVERTENZA 

PERICOLO DI ESPLOSIONI 

IN UN AMBIENTE FACILMENTE INFIAMMABILE, NON DEVONO ESSERE COLLEGATI 
O SCOLLEGATI CAVI ALL'APPARECCHIO/DALL'APPARECCHIO. 

 

 

 AVVERTENZA 

PERICOLO DI ESPLOSIONI 

LA SOSTITUZIONE DI COMPONENTI PUÒ COMPROMETTERE L'IDONEITÀ PER LA 
CLASS I, DIVISION 2 O ZONE 2. 

 

 

 AVVERTENZA 

PERICOLO DI ESPLOSIONI 

NON APRIRE L'APPARECCHIO CON LA TENSIONE DI ALIMENTAZIONE INSERITA. 
 

 

 AVVERTENZA 

Il dispositivo può essere utilizzato solo in un ambiente con grado di imbrattamento 1 o 2 
(cfr. IEC60664-1). 

 

 

 AVVERTENZA 

L'apparecchio è progettato per il funzionamento con una tensione di sicurezza a basso 
voltaggio collegabile direttamente (Safety Extra Low Voltage, SELV) tramite 
un'alimentazione con potenza limitata (Limited Power Source, LPS). 

Per questo motivo possono essere collegate solo tensioni di sicurezza a basso voltaggio 
(SELV) con potenza limitata (Limited Power Source, LPS) secondo IEC 60950-1 / 
EN 60950-1 / VDE 0805-1 con i collegamenti di alimentazione oppure la tensione di rete 
per l'alimentazione dell'apparecchio deve corrispondere a NEC Class 2 secondo il National 
Electrical Code (r) (ANSI / NFPA 70). 

Se l'apparecchio viene collegato ad un'alimentazione ridondante (due alimentazioni 
separate), entrambe le alimentazioni devono soddisfare i requisiti richiesti. 

 



 Avvertenze di sicurezza 
 2.3 Avvertenze per l'impiego nell'area Ex secondo ATEX e IECEx 
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 AVVERTENZA 

Se l'apparecchio viene utilizzato ad una temperatura ambiente superiore a 45 °C, la 
temperatura del contenitore dell'apparecchio può essere superiore a 70 °C. La posizione di 
montaggio del dispositivo deve quindi essere in una zona di accesso limitata, accessibile 
solo al personale di manutenzione o a utenti che sono stati informati sul motivo della 
limitazione di accesso e sulle misure di sicurezza necessarie in caso di una temperatura 
ambiente superiore a 45 °C. 

 

2.3 Avvertenze per l'impiego nell'area Ex secondo ATEX e IECEx 

Avvertenze di sicurezza in caso di impiego secondo ATEX e IECEx 

Se si utilizza il dispositivo in condizioni ATEX o IECEx, oltre alle avvertenze di sicurezza 
generali per la protezione da esplosione è necessario osservare anche le seguenti 
avvertenze di sicurezza: 

 

 AVVERTENZA 

Per soddisfare la direttiva UE 94/9 (ATEX 95) o le condizioni di IECEx, la custodia o il 
quadro di comando deve soddisfare almeno i requisiti richiesti da IP 54 secondo EN 60529. 

 

 

 AVVERTENZA 

Adottare misure per evitare sovratensioni transienti superiori al 40% della tensione 
nominale. Questo viene garantito se l'apparecchio viene utilizzato esclusivamente con 
SELV (tensione di sicurezza a basso voltaggio). 

 

 

 AVVERTENZA 

Misure di sicurezza in caso di temperatura aumentata 

Se sul cavo o sulla presa della custodia si verificano temperature superiori a 70 °C o se la 
temperatura sui punti di diramazione dei conduttori dei cavi è superiore 80 °C, è necessario 
adottare particolari misure. Se il dispositivo viene utilizzato ad temperature ambiente 
comprese tra 50 °C e 70 °C, vanno utilizzati cavi con una temperatura d'esercizio ammessa 
di almeno 100 °C. 
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2.4 Avvertenze in caso di utilizzo in aree soggette a rischio di 
esplosione secondo UL-Hazloc 

Avvertenze di sicurezza in caso di utilizzo conforme a Underwriters Laboratories for 
Hazardous Locations (UL-HazLoc) 

Se si utilizza l'apparecchio in condizioni UL-HazLoc, oltre alle avvertenze di sicurezza 
generali per la protezione da esplosione è necessario osservare anche le seguenti 
avvertenze di sicurezza: 

 

 AVVERTENZA 

PERICOLO DI ESPLOSIONI 

Non scollegare l'apparecchio dai cavi che conducono tensione fino a quando non si è sicuri 
che nell'ambiente non sia presente atmosfera a rischio di esplosione. 

 

Questo apparecchio è adatto solo per l'impiego in aree secondo Class I, Division 2, Groups 
A, B, C e D e in aree non soggette a pericolo di esplosione. 

Questo apparecchio è adatto solo per l'impiego in aree secondo Class I, Zone 2, Group IIC e 
in aree non soggette a pericolo di esplosione. 

2.5 Avvertenze in caso di utilizzo in aree soggette a rischio di 
esplosione secondo UL 

Valida solo nel campo di validità di NEC o CEC 
 

 AVVERTENZA 

Warning for areas subject to NEC or CEC: 

Safety notice for connectors with LAN (Local Area Network) marking: 

A LAN or LAN segment, with all its associated interconnected equipment, shall be entirely 
contained within a single low-voltage power distribution and within a single building. The 
LAN is considered to be in an "environment A" according IEEE802.3 or "environment 0" 
according IEC TR 62102, respectively. 

Never make direct electrical connection to TNV-circuits (Telephone Network) or WAN 
(Wide Area Network). 
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 Descrizione 3 
3.1 Dati tecnici 

 
Collegamenti   
Collegamenti di terminali o componenti di rete tramite Twisted Pair  10/100/1000 Mbit/s (halfduplex/fullduplex) 
SCALANCE S602/S612 2x prese RJ–45 con assegnazione MDI-X  
SCALANCE S623 3 x prese RJ–45 con assegnazione MDI-X 
SCALANCE S627-2M 3 x prese RJ-45 con assegnazione MDI-X 

2x slot moduli mediali per rispettivamente un modulo 
mediale a 2 porte 

Collegamento per tensione di alimentazione 1 morsettiera innestabile a 4 poli 
Collegamento per contatto di segnalazione 1 morsettiera innestabile a 2 poli 
Dati elettrici   
Tensione di alimentazione Alimentazione DC 24 V (DC 19,2 ... 28,8 V) 

• eseguita in modo ridondante 
• tensione di sicurezza a basso voltaggio (SELV) 

Potenza assorbita caratteristica con DC 24 V, 1000 Mbit/s 
SCALANCE S602/S612 9,0 W 
SCALANCE S623 9,7 W 
SCALANCE S627-2M 12,0 W senza modulo mediale / max. 2,5 W supple-

mentari per ciascun modulo mediale 
Massima corrente assorbita con tensione nominale 
SCALANCE S602/S612 0,5 A 
SCALANCE S623 0,5 A 
SCALANCE S627-2M 0,7 A 
Lunghezze di cavi ammesse   
Collegamento tramite cavi Industrial Ethernet FC TP 
0 - 100 m Industrial Ethernet FC TP Standard Cable con 

IE FC RJ–45 Plug 180 
o  
tramite Industrial Ethernet FC Outlet RJ–45 con 
0 - 90 m Industrial Ethernet FC TP Standard Cable 
+ 10 m TP Cord  

0 - 85 m Industrial Ethernet FC TP Marine/Trailing Cable con 
IE FC RJ–45 Plug 180 
o 
0 - 75 m Industrial Ethernet FC TP Marine/Trailing 
Cable + 10 m TP Cord 
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Condizioni ambientali ammesse di SCALANCE S602 / S612 / S623  
Temperatura di esercizio (nella posizione di montaggio) 
Guida profilata orizzontale (posizione normale) 
Tutte le altre posizioni di montaggio (ad es. guida profilata vertica-
le) 

 
-40 °C ... +60 °C 
-40 °C ... +40 °C 

Temperatura di magazzinaggio/trasporto -40 °C ... +80 °C 
Umidità massima relativa in esercizio 95 % (senza condensa) 
Temperatura ambiente massima ad un'altezza di esercizio fino a 2000 m s.l.m ad una temperatura ambiente di 

max. 56 °C 
fino a 3000 m s.l.m ad una temperatura ambiente di 
max. 50 °C 

Condizioni ambientali ammesse di SCALANCE S627-2M  
Modulo mediale: Temperatura di eserci-

zio (nella posizione di 
montaggio): 

Temperatura di 
magazzinag-
gio/trasporto: 

Umidità relativa mas-
sima durante l'eser-
cizio a 25 °C: 

Temperatura am-
biente massima ad 
un'altezza di eserci-
zio: 

Senza o con i seguenti moduli 
mediali: 
• MM991-2 (BFOC) 
• MM991-2LD (BFOC) 
• MM991-2 (SC) 
• MM991-2LH+ 
• MM991-2LD (SC) 
• MM992-2 
• MM992-2LD 
• MM992-2LH 
• MM992-2LH+ 
• MM992-2ELH 
• MM992-2CUC 
• MM992-2CU 
• MM992-2M12 
• MM992-2VD 

Guida profilata oriz-
zontale (posizione 
normale): -40 °C ... 
+60 °C 
Tutte le altre posizioni 
di montaggio (ad es. 
guida profilata vertica-
le): -40 °C ... +50 °C 

-40 °C ... +80 °C 95 % (senza con-
densa) 

Guida profilata oriz-
zontale (posizione 
normale): 
• fino a 2000 m 

s.l.m a max. 56 
°C 

• fino a 3000 m 
s.l.m a max. 50 
°C 

Tutte le altre posi-
zioni di montaggio 
(ad es. guida profila-
ta verticale): 
• fino a 2000 m 

s.l.m a max. 40 
°C 

• fino a 3000 m 
s.l.m a max. 35 
°C 
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Con modulo mediale MM992-
2SFP e i seguenti transceiver 
SFP:  
• SFP991-1 
• SFP991-1LH+ 
• SFP991-1LD 
• SFP992-1 
• SFP992-1LD 
• SFP992-1LH 
• SFP992-1LH+ 
• SFP992-1ELH 
• SFP991-1ELH200 

Guida profilata oriz-
zontale (posizione 
normale): -40 °C ... 
+50 °C 
Tutte le altre posizioni 
di montaggio (ad es. 
guida profilata vertica-
le): -40 °C ... +40 °C 

-40 °C ... +80 °C 95 % (senza con-
densa) 

Guida profilata oriz-
zontale (posizione 
normale): 
• fino a 2000 m 

s.l.m a max. 45 
°C 

• fino a 3000 m 
s.l.m a max. 40 
°C 

Tutte le altre posi-
zioni di montaggio 
(ad es. guida profila-
ta verticale): 
• fino a 2000 m 

s.l.m a max. 40 
°C 

• fino a 3000 m 
s.l.m a max. 35 
°C 

Omologazioni   
ATEX Zone 2 EN 60079-15 
Struttura costruttiva 
Possibilità di montaggio • Guida a U DIN di 35 mm 

• Guida profilata S7-300 
• Montaggio a parete 

Dimensioni (L x A x P) in mm 
SCALANCE S602/S612/S623 60 x 125 x 124 
SCALANCE S627-2M 120 x 125 x 124 
Peso in g 
SCALANCE S602/S612 790 
SCALANCE S623 815 
SCALANCE S627-2M 1300 
Numeri articolo   
SCALANCE S602 6GK5602-0BA10-2AA3 
SCALANCE S612 6GK5612-0BA10-2AA3 
SCALANCE S623 6GK5623-0BA10-2AA3 
SCALANCE S627-2M 6GK5627-2BA10-2AA3 
Manuale "Industrial Communication SIMATIC NET Industrial 
Ethernet Ethernet Manuale di rete manuale di sistema" 

6GK1970-1BA10-0AA0 

Numeri di articolo per moduli mediali supportati (per SCALANCE S627-2M) 
MM991-2 (BFOC) 6GK5991-2AB00-8AA0 
MM991-2LD (BFOC) 6GK5991-2AC00-8AA0 
MM991-2 (SC) 6GK5991-2AD00-8AA0 
MM991-2LH+ 6GK5991-2AE00-8AA0 
MM991-2LD (SC) 6GK5991-2AF00-8AA0 
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MM992-2 6GK5992-2AL00-8AA0 
MM992-2LD 6GK5992-2AM00-8AA0 
MM992-2LH 6GK5992-2AN00-8AA0 
MM992-2LH+ 6GK5992-2AP00-8AA0 
MM992-2ELH 6GK5992-2AQ00-8AA0 
MM992-2CUC 6GK5992-2GA00-8AA0 
MM992-2CU 6GK5992-2SA00-8AA0 
MM992-2M12 6GK5992-2HA00-0AA0 
MM992-2VD 6GK5992-2VA00-8AA0 
Numero di articolo per il modulo mediale SFP supportato (per SCALANCE S627-2M) 
MM992-2SFP 6GK5992-2AS00-8AA0 
Numeri di articolo per SFP supportati (per modulo mediale SFP) 
SFP991-1 6GK5991-1AD00-8AA0 
SFP991-1LH+ 6GK5991-1AE00-8AA0 
SFP991-1LD 6GK5991-1AF00-8AA0 
SFP991-1ELH200 6GK5991-1AE30-8AA0 
SFP992-1 6GK5992-1AL00-8AA0 
SFP992-1LD 6GK5992-1AM00-8AA0 
SFP992-1LH 6GK5992-1AN00-8AA0 
SFP992-1LH+ 6GK5992-1AP00-8AA0 
SFP992-1ELH 6GK5992-1AQ00-8AA0 
Numeri di articolo per accessori 
IE FC Stripping Tool 6GK1901-1GA00 
IE FC Blade Cassettes 6GK1901-1GB00 
IE FC TP Standard Cable (Fast Ethernet) 6XV1840-2AH10 
IE FC TP Trailing Cable (Fast Ethernet) 6XV1840-3AH10 
IE FC TP Marine Cable (Fast Ethernet) 6XV1840-4AH10 
IE FC TP Standard Cable 4X2(Gigabit Ethernet) 6XV1870-2E 
IE FC TP Flexible Cable 4X2 (Gigabit Ethernet) 6XV1870-2H 
IE FC RJ45 Plug 180 (Fast Ethernet) 
Unità confezione = 1 pezzo 

6GK1901-1BB10-2AA0 

IE FC RJ45 Plug 180 (Fast Ethernet) 
Unità confezione = 10 pezzo 

6GK1901-1BB10-2AB0 

IE FC RJ45 Plug 180 (Fast Ethernet) 
Unità confezione = 50 pezzo 

6GK1901-1BB10-2AE0 

IE FC RJ45 Plug 180 4X2 (Gigabit Ethernet) 
Unità confezione = 1 pezzo 

6GK1901-1BB11-2AA0 

IE FC RJ45 Plug 180 4X2 (Gigabit Ethernet) 
Unità confezione = 10 pezzo 

6GK1901-1BB11-2AB0 

IE FC RJ45 Plug 180 4X2 (Gigabit Ethernet) 
Unità confezione = 50 pezzo 

6GK1901-1BB11-2AE0 

IE FC M12 Plug PRO 4x2 (Gigabit Ethernet) 
Unità confezione = 1 pezzo 

6GK1901-0DB30-6AA0 
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IE FC M12 Plug PRO 4x2 (Gigabit Ethernet) unità confezione = 8 
pezzi 

6GK1901-0DB30-6AA8 

FC FO Termination Kit 6GK1900-1GL00-0AA0 
FC FO Standard Cable GP 6XV1847-2A 
FC FO Trailing Cable 6XV1847-2C 
FC SC Plug, unità confezione = 10 pezzi 6GK1900-1LB00-0AC0 
FC BFOC Plug, unità confezione = 20 pezzi 6GK1900-1GB00-0AC0 
FC SC Coupler, unità confezione = 5 pezzi 6GK1900-1LP00-0AB0 
 FC BFOC Coupler, unità confezione = 10 pezzi 6GK1900-1GP00-0AB0 
C-PLUG MLFB 6GK1900-0AB00 
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3.2 Caratteristiche hardware 
Tutti i dispositivi SCALANCE S offrono le seguenti potenzialità fondamentali: 

Hardware  
● Custodia robusta con grado di protezione IP 20 

● Montaggio a scelta su guida ad U S7-300 o DIN di 35 mm, montaggio a parete 

● Alimentazione ridondante  

● Contatto di segnalazione 

 
Figura 3-1 SCALANCE S627-2M 

3.3 Fornitura 

Che cosa è compreso nella fornitura di SCALANCE S?  
● Dispositivo SCALANCE S 

● Morsettiera innestabile a 2 poli (contatto di segnalazione)  

● Morsettiera innestabile a 4 poli (alimentazione) 
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● Informazioni relative al prodotto 

● DVD con il seguente contenuto:  

– Manuale 

– Software di progettazione Security Configuration Tool 

3.4 Tensione di alimentazione 
 

 AVVERTENZA 

Utilizzare solo tensione di sicurezza a basso voltaggio 

Il dispositivo SCALANCE S è concepito per l'esercizio con tensione di sicurezza a basso 
voltaggio. Di conseguenza ai collegamenti di alimentazione possono essere collegate solo 
tensioni di sicurezza a basso voltaggio (SELV) secondo IEC950/EN60950/ VDE0805.  

L'alimentatore per l'alimentazione di SCALANCE S deve corrispondere a NEC Class 2 
(campo di tensione 19,2 - 28,8 V). 

Il dispositivo può essere alimentato solo con un'unità di alimentazione che risponde alle 
richieste della classe 2 per alimentazioni dellla "National Electrical Code,table 11 (b)". In 
caso di una struttura con alimentazione ridondante (due alimentazioni separate) devono 
essere soddisfatti entrambi i requisiti.  

 

 Nota 

Non collegare mai SCALANCE S a tensione alternata o a tensioni continue superiore a 
DC 28,8 V.  

 

Il collegamento dell'alimentazione viene eseguito con una morsettiera innestabile a 4 poli. 
L'alimentazione può essere collegata in modo ridondante. Entrambi gli ingressi sono 
disaccoppiati. Non esiste una ripartizione del carico. In caso di alimentazione ridondante, 
l'alimentatore con la tensione di uscita maggiore fornisce l'alimentazione di SCALANCE S. 
La tensione di alimentazione è collegata ad alta resistenza alla custodia per consentire un 
montaggio senza collegamento a terra.  
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Figura 3-2 Alimentazione in SCALANCE S627-2M 

3.5 Contatto di segnalazione 
 

 Nota 

Il contatto di segnalazione deve essere caricato al massimo con 100 mA (tensione di 
sicurezza (SELV), DC 24 V).  

Non collegare mai il contatto di segnalazione di SCALANCE S a tensione alternata o a 
tensioni continue superiore a DC 32 V. I poli dei collegamenti non sono rilevanti. 

 

Il collegamento del contatto di segnalazione viene eseguito tramite una morsettiera 
innestabile a 2 poli. Il contatto di segnalazione è un interruttore senza potenziale con il quale 
vengono segnalati stati di errore tramite interruzione del contatto.  

Con il contatto di segnalazione possono essere segnalati i seguenti errori: 

● errori nella tensione di alimentazione 

● errori interni 

In caso di errore o se SCALANCE S è senza tensione, il contatto di segnalazione è aperto. 
In caso di funzionamento senza errori il contatto di segnalazione è chiuso. 
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Figura 3-3 Contatto di segnalazione in SCALANCE S627-2M 
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3.6 Indicatori 

 
Figura 3-4 Indicatori di funzionamento 

 

① Indicatore di stato porta P1 

② Indicatore di stato porta P2 

③ Indicatore di stato porta P3 

④ Indicatore di stato porta P4 

⑤ Indicatore di stato porta P5 

⑥ Indicatore di stato porta P6 

⑦ Indicatore di stato porta P7 

⑧ Indicatore Fault (F) e indicatore Power (L1, L2) 
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Indicatori di guasto (LED guasto)  
Indicatore dello stato operativo: 
 
Stato Significato 
si accende la luce rossa Il dispositivo riconosce un errore 

(il contatto di segnalazione è aperto) 
Vengono riconosciuti i seguenti errori: 
• errore interno (ad es. avvio non riuscito) 
• C-PLUG non valido (formattazione non valida) 

si accende la luce verde Il dispositivo è nel funzionamento produttivo 
(il contatto di segnalazione è chiuso) 

non si accende Il dispositivo si è guastato; nessuna tensione di alimentazione 
(il contatto di segnalazione è aperto) 

si accende la luce arancione 
(luce permanente) 

Il dispositivo è in avvio 
(il contatto di segnalazione è aperto) 
Se non è stato assegnato nessun indirizzo IP, il dispositivo rimane 
in questo stato. 

lampeggia ad intermittenza luce 
arancione-rossa 

Il dispositivo ritorna allo stato della fornitura 
(il contatto di segnalazione è aperto) 

Indicatore Power (L1, L2)  
Lo stato della tensione di alimentazione viene segnalato con 2 LED: 
 
Stato Significato 
LED L1 / L2 
si accende la luce verde La tensione di alimentazione L1 e L2 è collegata. 
non si accende In funzionamento non ridondante: La tensione di alimentazione L1 

e L2 non è attiva o <14 V (L+) 
si accende la luce rossa Nel funzionamento ridondante: Una delle due tensione di alimen-

tazione L1 o L2 collegate si è guastata durante il funzionamento o 
<14 V (L+)  

Indicatore dello stato della porta (LED verdi/gialli)  
Lo stato delle interfacce viene rispettivamente segnalato per ogni porta tramite un LED 
bicolore. 
 
Tipo di 
dispositivo 

Numero LED porta LED si accende con luce verde LED si accende con luce 
gialla 

S602 2 Link TP esistente, nessuna 
ricezione dati. 

Link TP esistente, scambio di 
dati sulla porta TP. S612 2 

S623 3 
S627-2M 7 
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 Nota 
Fase di apprendimento di SCALANCE S602 in modalità Ghost 

Mentre SCALANCE S602 apprende gli indirizzi IP del nodo interno in modalità Ghost, i due 
LED della porta di SCALANCE S602 ≥ V3.1 lampeggiano in modo sincrono in base al 
seguente modello, se simultaneamente non ha luogo nessun altro scambio di dati: "Lungo - 
Lungo - Breve". 
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 Pianificazione di impiego 4 
4.1 Apertura della confezione e controllo 

Apertura della confezione, controllo 
1. Controllare che il pacchetto sia completo. 

2. Controllare che i singoli pezzi non presentino danni dovuti al trasporto. 

 

 
 AVVERTENZA 

Mettere in servizio solo pezzi non danneggiati. 
 

4.2 Collegamento a Ethernet 

Possibilità di collegamento  
Ciascun dispositivo SCALANCE S dispone di un determinato numero di porte alle quali 
possono essere collegati i nodi di rete. In base alla rispettiva interfaccia, i nodi di rete 
vengono trattati in modo diverso. 

 
Dispositivo SCALANCE S Interfaccia Porte dell'interfaccia Tipo di porta 
SCALANCE S602/S612 Esterno P1 Presa RJ-45 montata in modo fissa 

(rame) 
Interno P2 Presa RJ-45 montata in modo fissa 

(rame) 
SCALANCE S623 Esterno P1 Presa RJ-45 montata in modo fissa 

(rame) 
Interno P2 Presa RJ-45 montata in modo fissa 

(rame) 
DMZ P3 Presa RJ-45 montata in modo fissa 

(rame) 
SCALANCE S627-2M Esterno P1 Presa RJ-45 montata in modo fissa 

(rame) 
P4 Porta modulo mediale (rame/FO) 
P5 Porta modulo mediale (rame/FO) 

Interno P2 Presa RJ-45 montata in modo fissa 
(rame) 

P6 Porta modulo mediale (rame/FO) 
P7 Porta modulo mediale (rame/FO) 
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Dispositivo SCALANCE S Interfaccia Porte dell'interfaccia Tipo di porta 
DMZ P3 Presa RJ-45 montata in modo fissa 

(rame) 

Le interfacce Ethernet non devono essere scambiate durante il collegamento alla rete di 
comunicazione: 

● Interfaccia X1 - esterna 

Contrassegno rosso = area di rete non protetta; 

● Interfaccia X2 - interna 

Contrassegno verde = rete protetta con SCALANCE S; 

● Interfaccia X3 - DMZ (interfaccia di rete universale) 

Contrassegno giallo = area di rete non protetta o rete protetta con SCALANCE S. 

In caso di scambio delle interfacce il dispositivo perde la sua funzione di protezione. 
 

 Nota 

Alle porte TP nella versione RJ–45 possono essere collegati TP-Cord o TP-XP-Cord con una 
lunghezza massima di 10 m. 

In combinazione con Industrial Ethernet FastConnect IE FC Standard Cable e IE FC RJ–45 
Plug 180, tra due dispositivi è consentita una lunghezza complessiva del cavo di max. 100 
m. 

 

 Nota 
4x2 cavo TP necessario per il collegamento Gigabit 

Per una trasmissione dei dati a 1000 MBit/s è necessario collegare i dispositivi con funzione 
Gigabit a SCALANCE S ≥ V4 con 4x2 cavi TP (Twisted Pair). 

 

Ulteriori informazioni relative al cablaggio tramite Industrial Ethernet si trovano in Internet 
alla seguente ID articolo: 27069465 
(http://support.automation.siemens.com/WW/view/it/27069465) 

Autonegotiation  
Il dispositivo SCALANCE S supporta l'Autonegotiation. 

Autonegotiation significa che i parametri di collegamento e di trasmissione vengono 
negoziati automaticamente con i componenti di rete collegati all'interfaccia di SCALANCE S.  

Funzione MDI /MDIX autocrossing  
Il dispositivo SCALANCE S supporta la funzione MDI / MDIX Autocrossing. 

La funzione MDI /MDIX autocrossing offre il vantaggio di un cablaggio continuo, senza che 
sia necessario un cavo Ethernet esterno incrociato. In questo modo vengono impedite 
funzioni errate in caso di cavi di trasmissione e di ricezione scambiati. In questo modo 
l'installazione viene notevolmente semplificata. 

http://support.automation.siemens.com/WW/view/it/27069465
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La funzione MDI / MDIX Autocrossing può essere utilizzata solo se l'Autonegotiation è 
arrivata. 

Isolamento tra le porte TP  
Tra le porte TP viene mantenuta una tensione di isolamento di 1,5 kV (corrisponde a 
IEEE802.3 cap. 33.4.1.1, Environment B). 

Vedere anche 
Dati tecnici (Pagina 11) 

4.3 Tasto Reset - Ripristino della configurazione all'impostazione di 
fabbrica 

SCALANCE S dispone di un tasto Reset. Il tasto Reset si trova sul lato posteriore del 
dispositivo, sotto il tappo M32, immediatamente sopra al C-PLUG.  

 
Figura 4-1 Tasto reset e posto connettore per il C-PLUG 

 

 Nota 

Assicurarsi che al dispositivo SCALANCE S acceda solo personale autorizzato. 
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Che funzione ha il pulsante Reset? 
Con il tasto Reset possono essere attivate due funzioni: 

● Riavvio 

L’apparecchio viene riavviato. La configurazione caricata viene mantenuta. 

● Ripristino delle impostazioni della fabbrica 

Il dispositivo viene riavviato e riportato allo stato della fornitura. Una configurazione 
caricata sul dispositivo SCALANCE S o su un C-PLUG innestato viene cancellata. 

Riavvio - Procedimento 
1. Smontare eventualmente il dispositivo SCALANCE S per consentire l'accesso al vano sul 

retro del dispositivo. Il vano è protetto con un tappo con chiusura a vite. 

2. Rimuovere i tappi M32 sul lato posteriore del dispositivo. 

Il pulsante Reset si trova nel vano sul lato posteriore di SCALANCE S, direttamente 
sopra al posto connettore per il C-PLUG. 

3. Premere il tasto Reset per meno di 5 secondi. 

Il riavvio dura fino a 2 minuti. Durante il riavvio l'indicatore Fault lampeggia con luce 
arancione. Fare attenzione che durante questa operazione l'alimentazione non venga 
interrotta.  

Alla conclusione del riavvio il dispositivo passa automaticamente nel funzionamento 
produttivo. L'indicatore Fault è successivamente acceso con luce verde permanente. 

4. Chiudere il vano con il tappo M32 e montare il dispositivo. 

Ripristino delle impostazioni della fabbrica - Procedimento  
 

 Nota 

Se durante il ripristino delle impostazioni di fabbrica è innestato un C-PLUG, il C-PLUG 
viene cancellato. 

 

1. Smontare eventualmente il dispositivo SCALANCE S per consentire l'accesso al vano sul 
retro del dispositivo. Il vano è protetto con un tappo con chiusura a vite. 

2. Rimuovere i tappi M32 sul lato posteriore del dispositivo. 

Il pulsante Reset si trova nel vano sul lato posteriore di SCALANCE S, direttamente 
sopra al posto connettore per il C-PLUG. 
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3. Tenere premuto il tasto Reset per almeno 5 secondi fino a quando l'indicatore Fault 
arancione-rosso lampeggia. 

Il ripristino dura fino a 2 minuti. Durante il ripristino l'indicatore Fault lampeggia con luce 
arancione-rossa. Fare attenzione che durante questa operazione l'alimentazione non 
venga interrotta.  

Alla conclusione del ripristino il dispositivo si riavvia automaticamente. Il riavvio dura fino 
a 2 minuti. Durante il riavvio l'indicatore Fault lampeggia con luce arancione. Fare 
attenzione che durante questa operazione l'alimentazione non venga interrotta.  

4. Chiudere il vano con il tappo M32 e montare il dispositivo. 

4.4 C-PLUG (Configuration Plug) 

Campo d'impiego  
Il C-PLUG è un supporto dati per il salvataggio dei dati di configurazione e di progettazione 
del dispositivo di base (SCALANCE S). Di conseguenza, in caso di sostituzione del 
dispositivo di base i dati di configurazione rimangono a disposizione. 

Principio del funzionamento 
L'alimentazione elettrica viene eseguita con il dispositivo di base. In assenza di corrente il C-
PLUG mantiene i dati in permanenza. 

Rimozione del C-PLUG  
La rimozione del C-PLUG è necessaria solo in caso di guasto (errore hardware) del 
dispositivo di base. 

 

 ATTENZIONE 

Osservare lo stato operativo 

Il C-PLUG può essere rimosso solo in assenza di tensione. 
 

Sostituzione del C-PLUG  
 

 ATTENZIONE 

Danneggiamento dell'hardware dovuto alla sostituzione durante il funzionamento 

Una sostituzione del C-PLUG durante il funzionamento può comportare il danneggiamento 
dell'hardware (dispositivo o C-PLUG).  

Selezionare il C-PLUG solo con il dispositivo disinserito. 
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Inserimento e rimozione del C-PLUG  
Il posto connettore per il -PLUG si trova sul lato posteriore del dispositivo. Per inserire il  
C-PLUG procedere nel modo seguente: 

1. Rimuovere il tappo M32.  

2. Spostare il C-PLUG nel vano previsto. 

3. Chiudere quindi il vano con il tappo M32. 

 
Figura 4-2 Inserire il C-PLUG nel dispositivo e togliere il C-PLUG dal dispositivo con l'aiuto di un 

cacciavite 

Funzionamento 
Su un C-PLUG non scritto (alla fornitura), durante l'avvio del dispositivo vengono spostati 
automaticamente tutti i dati di configurazione di SCALANCE S. Anche le modifiche della 
configurazione durante il funzionamento vengono salvate sul C-PLUG senza l'intervento 
dell'utente.  

Un dispositivo di base con C-PLUG innestato utilizza automaticamente durante l'avvio i dati 
di configurazione di un C-PLUG innestato. Il presupposto è che i dati siano stati scritti da un 
tipo di dispositivo compatibile. 
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In questo modo, in caso di guasto viene consentita una sostituzione rapida e semplice del 
dispositivo di base. In caso di sostituzione il C-PLUG viene tolto dal componente guastatosi 
e innestato nel pezzo di ricambio. Dopo il primo avvio il dispositivo sostitutivo dispone 
automaticamente della stessa configurazione del dispositivo guastatosi.  

 

 Nota 
Dati di progetto coerenti - Adattamento dell'indirizzo MAC  

Dopo la sostituzione del dispositivo con uno sostitutivo i dati di progettazione devono essere 
coerenti. L'indirizzo MAC nella progettazione deve essere adattato all'indirizzo MAC 
stampigliato sul dispositivo sostitutivo. 

Se nel dispositivo sostitutivo si utilizza il C-PLUG già configurato del dispositivo sostituito, 
non è strettamente necessario questo provvedimento per l'avvio e il funzionamento del 
dispositivo.  

 

 Nota 
Ripristino delle impostazioni della fabbrica 

Se durante il ripristino delle impostazioni di fabbrica è innestato un C-PLUG, il C-PLUG 
viene cancellato.  

 

 Nota 
Controllo dell'ora dopo l'inserimento del C-PLUG 

Dopo aver inserito il C-PLUG in un nuovo dispositivo è necessario controllare l'ora sul 
dispositivo in merito alla validità dei certificati. 
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Utilizzo di un C-PLUG con dati di progettazione già esistenti 
Utilizzare solo C-PLUG formattati per il rispettivo tipo di dispositivo SCALANCE S. I C-PLUG 
utilizzati in altri tipi di dispositivi e formattati per altri tipi di dispositivi non devono essere 
utilizzati. 

Rilevare dalla seguente tabella il C-PLUG che può essere utilizzato per il tipo di dispositivo 
SCALANCE S: 
 

Tipo di dispositivo 
SCALANCE S 

C-PLUG formattato da 
S602 V2 S612 V2 / 

S613 V2 
S602 

V3 
S602 ≥ 
V3.1 in 

modalità 
Ghost 

S602 V4 S612 
V3 

S612 
V4 

S623 
V3 

S623 
V4 

S627-
2M V4 

S602 V2 x - - - - - - - - - 
S612 V2 / 
S613 V2 

- x - - - - - - - - 

S602 V3 x - x - - - - - - - 
S602 ≥ V3.1 in modali-

tà Ghost 
- - - x - - - - - - 

S602 V4 x - x x x - - - - - 
S612 V3 - x - - - x - - - - 
S612 V4 - x - - - x x - - - 
S623 V3 - - - - - - - x - - 
S623 V4 - - - - - - - x x - 

S627-2M V4 - - - - - - - - - x 
 

 
x C-PLUG utilizzabile con il tipo di dispositivo 
- C-PLUG non utilizzabile con il tipo di dispositivo 

Prima di poter utilizzare un C-PLUG formattato per un altro apparecchio, è necessario 
resettare alle impostazioni di fabbrica il modulo Security con il C-PLUG inserito premendo il 
tasto Reset e successivamente caricare il progetto desiderato sul dispositivo SCALANCE S. 
L'utilizzo di C-PLUG formattati senza identificazione di unità è possibile anche senza reset 
alle impostazioni di fabbrica. 

Procedimento dopo la rimozione o il danneggiamento di un C-PLUG 
Dopo l'inserimento di un C-PLUG i dati di progettazione di SCALANCE S vengono copiati nel 
C-PLUG e cancellati dalla memoria permanente del dispositivo SCALANCE S. Per questo 
motivo, dopo la rimozione o un danneggiamento di un C-PLUG innestato non sono più 
disponibili dati di progettazione. Per rimettere in servizio SCALANCE S, caricare la 
progettazione desiderata in SCALANCE S o inserire un C-PLUG nello SCALANCE S con la 
progettazione desiderata. 
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Diagnostica 
L'innesto di un C-PLUG, che contiene la configurazione di un tipo di dispositivo non 
compatibile e la rimozione del C-PLUG durante il funzionamento o funzioni di errore generali 
del C-PLUG vengono segnalati con i dispositivi di diagnostica del terminale di dati (indicatore 
Fault rosso). 
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 Montaggio 5 
5.1 Avvertenze per il montaggio 
 

 Nota 
Osservanza delle direttive di montaggio corrispondenti 

Durante l'installazione e la messa in servizio osservare le direttive di montaggio e le 
avvertenze di sicurezza riportate sia nella presente descrizione sia nel manuale "Industrial 
Communication SIMATIC NET Industrial Ethernet Manuale di rete Manuale di sistema" (ID 
articolo: 27069465 (http://support.automation.siemens.com/WW/view/it/27069465)). 

 

 

 CAUTELA 

Proteggere l'apparecchio dalla luce solare diretta con un apposito riparo. Questo evita un 
riscaldamento indesiderato dell'apparecchio e un invecchiamento precoce dell'apparecchio 
e del cablaggio. 

 

 

 Nota 

I requisiti richiesti secondo EN61000-4-5, Surge controllo dei cavi di alimentazione, vengono 
soddisfatti solo in caso di impiego di un parafulmine BVT AVD 24V art. N. 918 422.  

Produttore: 
DEHN+SÖHNE GmbH+Co. KG, Hans Dehn Str.1, Postfach 1640, D-92306 Neumarkt. 

 

5.2 Tipi di montaggio 

Tipi di montaggio  
SCALANCE S consente diversi tipi di montaggio: 

● Montaggio su una guida ad U DIN di 35 mm  

● Montaggio su una guida profilata SIMATIC S7-300  

● Montaggio a parete  

http://support.automation.siemens.com/WW/view/it/27069465
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5.2.1 Montaggio su una guida ad U 

Montaggio  
Montare SCALANCE S su una guida ad U di 35 mm secondo DIN EN 50022. 

1. Agganciare la guida a scatto superiore dell'aparecchio nella guida ad U e premerla verso 
il basso contro la guida ad U fino a quando scatta in posizione. 

2. Montare i cavi di collegamento elettrici e la morsettiera per il contatto di segnalazione. 

 
Figura 5-1 SCALANCE S Montaggio su una guida ad U DIN (35 mm) 
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Smontaggio  
Per smontare SCALANCE S dalla guida ad U: 

1. Smontare dapprima i cavi TP e sfilare la morsettiera per la tensione di alimentazione e il 
contatto di segnalazione. 

2. Sbloccare il dispositivo con un cacciavite dal blocco della guida ad U dal lato inferiore del 
dispositivo e sollevare quindi il dispositivo in basso dalla guida ad U. 

 
Figura 5-2 SCALANCE S Smontaggio da una guida ad U DIN (35 mm) 
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5.2.2 Montaggio su una guida profilata 

Montaggio su una guida profilata SIMATIC S7-300  
1. Agganciare la guida del contenitore sul lato superiore del contenitore di SCALANCE S 

nella guida profilata S7. 

2. Avvitare il dispositivo SCALANCE S al lato inferiore della guida profilata. 

 
Figura 5-3 SCALANCE S Montaggio su una guida profilata SIMATIC S7-300  
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5.2.3 Montaggio a parete 

Materiale di montaggio 
Per il fissaggio - per esempio su una parete di cemento armato, utilizzare: 

● 4 tasselli da parete con diametro di 6 mm e lunghezza di 30 mm 

● Viti con diametro di 3,5 mm e lunghezza di 40 mm 

 
  Nota 

Il fissaggio a parete deve essere progettato in modo da poter sopportare almeno il peso 
quadruplo dell'apparecchio. 

 

5.2.4 Collegamento a terra 

Montaggio su una guida ad U  
Il collegamento a terra viene eseguito sulla guida ad U. 

Guida profilata S7-300   
Il collegamento a terra viene eseguito sul lato poteriore dell'apparecchio e con la vite con 
collare. 

Montaggio a parete   
Il collegamento a terra viene eseguito con la vite di fissaggio sul foro senza vernice. 

 

 Nota 

Fare attenzione che SCALANCE S deve essere collegato a terra a bassa resistenza tramite 
una vite di fissaggio. 
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 Messa in servizio 6 
 

 
 

 ATTENZIONE 

Da osservare prima della messa in servizio 

Prima della messa in servizio leggere assolutamente e con attenzione le indicazioni 
riportate nei capitoli "Proprietà del prodotto" e "Montaggio" seguire in particolare le 
istruzioni riportate nelle avvertenze per la sicurezza.  

 

Principio 
Per l'esercizio di uno SCALANCE S è necessario caricare una progettazione configurata con 
il Security Configuration Tool o STEP 7 a partire da V12. La progettazione tramite Security 
Configuration Tool viene descritta di seguito.  

Una configurazione di uno SCALANCE S comprende i seguenti aspetti parziali: 

● Selezione del modo di funzionamento 

● Parametro IP 

● Regole firewall 

● Tunnel IPSec (non per S602) 

Prima della messa in servizio è fondamentalmente possibile progettare offline l'intera 
configurazione e successivamente caricarla.  

A seconda dell'impiego, durante la messa in servizio caricare la configurazione 
simultaneamente in un dispositivo SCALANCE S o in più dispositivi SCALANCE S. 
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Figura 6-1 Grafica panoramica Messa in servizio 

 

Impostazioni della fabbrica  
Con le impostazioni della fabbrica (alla fornitura o dopo il "ripristino delle impostazioni della 
fabbrica"), dopo l'inserimento della tensione di alimentazione SCALANCE S ha il seguente 
comportamento: 

● Non è possibile una comunicazione IP in quanto mancano le impostazioni IP; in 
particolare SCALANCE S non dispone ancora di un indirizzo IP. 

Non appena a SCALANCE S è stato assegnato un indirizzo IP valido tramite 
configurazione, il dispositivo può essere raggiunto (successivamente è possibile la 
comunicazione IP). Se nella configurazione sono contenuti anche dati router caricati in 
SCALANCE S, il dispositivo è raggiungibile anche tramite router. 

● Il dispositivo ha un indirizzo MAC preimpostato in modo fisso; l'indirizzo MAC è 
stampigliato sul dispositivo; questo indirizzo va inserito durante la progettazione. 

● Il Firewall è preconfigurato con le seguenti regole di base del Firewall:  

– Tutti i telegrammi dall'interno all'esterno e viceversa sono bloccati. 

– Tutti i telegrammi dall'interno al dispositivo SCALANCE S sono autorizzati. 

– Per SCALANCE S623/S627-2M: Per quel che riguarda le impostazioni base del 
firewall, l'interfaccia DMZ si comporta come l'interfaccia esterna. 

Lo stato non configurato si riconosce dall'indicatore Fault arancione acceso. 

 



 Messa in servizio 
 6.1 Operazione 1: Collegamento del dispositivo SCALANCE S 

SCALANCE S V4 
Manuale di installazione e messa in servizio, 04/2015, C79000-G8972-C266-05 41 

6.1 Operazione 1: Collegamento del dispositivo SCALANCE S 

Procedimento: 
1. Disimballare dapprima SCALANCE S e controllare che i componenti non siano 

danneggiati. 

2. Inserire eventualmente i moduli mediali e gli SFP in SCALANCE S (solo S627-2M). 

 

 
 ATTENZIONE 

Montaggio e smontaggio dei moduli mediali solo in assenza di tensione 

I moduli mediali possono essere inseriti o rimossi in un apparecchio SCALANCE S solo 
se questo apparecchio è scollegato dalla tensione di alimentazione. 

Utilizzare solo moduli mediali e SFP approvati 

Nei posti connettore per moduli utilizzare solo moduli mediali e SFP supportati da 
SCALANCE S627-2M. Questi moduli mediali e SFP sono elencati nel seguente capitolo: 
• Dati tecnici (Pagina 11) 

 

3. Collegare la tensione di alimentazione a SCALANCE S. 

Risultato: dopo il collegamento della tensione di esercizio si accende l'indicatore Fault (F) 
giallo. 

4. Realizzare a questo punto i collegamenti di rete fisici innestando il connettore del cavo di 
rete nelle porte previste (prese RJ45 o porte modulo mediale). 

– Collegare l'interfaccia esterna alla rete esterna alla quale è collegato il PC/PG di 
progettazione. 

– Collegare l'interfaccia interna alla rete interna. 

– Collegare eventualmente l'interfaccia DMZ con i relativi componenti di rete. 

Osservazione: 

Durante la messa in servizio, in linea di principio è possibile collegare dapprima il PC/PG 
di progettazione ad una delle interfacce del dispositivo SCALANCE S e rinunciare al 
collegamento di altri nodi di rete fino a quando nel dispositivo è impostata una 
configurazione. In caso di collegamento diretto all'interfaccia SCALANCE S è tuttavia 
necessario configurare separatamente ogni singolo dispositivo SCALANCE S. 

Se si vuole utilizzare l'interfaccia DMZ per il caricamento iniziale di una configurazione 
(assegnazione di indirizzi IP iniziali alle interfacce), è necessario attivare l'interfaccia DZM 
in questa configurazione. Il caricamento inziale di una configurazione tramite l'interfaccia 
DMZ è possibile solo a partire da SCT V4.0. 

5. Proseguire quindi con l'operazione successiva "Progettazione e caricamento". 
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6.2 Operazione 2: Progettazione e caricamento 
Qui di seguito viene descritto come si progetta l'unità SCALANCE S partendo dalle 
impostazioni di fabbrica con il Security Configuration Tool. 

Procedimento: 
1. Avviare il software di progettazione Security Configuration Tool fornito. 

2. Selezionare la voce di menu "Progetto > Nuovo...". 

3. Creare nella seguente finestra di dialogo un nuovo utente con il nome utente e la 
rispettiva password. All'utente viene assegnato automaticamente il ruolo "Administrator". 
Confermare l'immissione con "OK". 

Risultato: Il nuovo progetto è creato. La finestra di dialogo "Selezione di un'unità o 
configurazione software" si apre  

4. Configurare il tipo di prodotto, l'unità e il release del firmware. 

5. Nell'area "Configurazione" inserire l'indirizzo MAC nel formato indicato. 

L'indirizzo MAC è stampigliato sul frontalino dell'unità SCALANCE S. 

 
6. Inserire l'indirizzo IP esterno e la maschera della sottorete esterna nei campi previsti e 

confermare la finestra di dialogo con "OK". 

Risultato: L'unità viene visualizzata nell'elenco delle unità configurate. 
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7. Selezionare l'unità e inserire eventualmente l'indirizzo IP del router standard facendo clic 
nella colonna "Router standard". 

 
Opzionel: Progettare eventualmente altre proprietà dell'unità. Informazioni dettagliate a 
riguardo si trovano nel manuale di progettazione "Industrial Ethernet Security - Nozioni di 
base e applicazioni Security", contenuti anch'essi nel supporto dati del prodotto. 

8. Salvare quindi il progetto con la seguente voce di menu: "Project" > "Save As…". 

9. Selezionare l'unità nell'area del contenuto e quindi la voce di menu "Trasferisci" > 
"All'unità...". 

Durante il primo caricamento di una configurazione dopo l'installazione del Security 
Configuration Tool compare una finestra di dialogo nella quale si può selezionare 
l'adattatore di rete desiderato. 

10.Facendo clic sul pulsante "Start" nella finestra di dialogo "Caricamento dei dati di 
configurazione nell'unità" si trasferisce la configurazione nell'unità SCALANCE S. 

 
Risultato: A questo punto l'unità SCALANCE S è configurata e può comunicare sul livello 
IP. Questo stato operativo viene segnalato dall'indicatore Fault attraverso luce verde. 
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 Troubleshooting/FAQs 7 
7.1 Sostituzione di un dispositivo SCALANCE S 

In caso di utilizzo di un C-PLUG la sostituzione di un dispositivo SCALANCE S può essere 
eseguita senza PC (senza dover caricare la configurazione sul nuovo dispositivo). Il C-PLUG 
del dispositivo da sostituire viene semplicemente innestato nel nuovo dispositivo che deve 
essere messo in servizio, vedere anche il seguente capitolo del presente manuale: 

● C-PLUG (Configuration Plug) (Pagina 27) 

 

 ATTENZIONE 

Danneggiamento dell'hardware dovuto alla sostituzione durante il funzionamento 

Una sostituzione del C-PLUG durante il funzionamento può comportare il danneggiamento 
dell'hardware (dispositivo o C-PLUG).  

Sostituire il C-PLUG solo con il dispositivo in assenza di tensione. 
 

7.2 Trasferimento del nuovo firmware 
Le nuove versioni firmware possono essere caricate in un dispositivo SCALANCE S con il 
Security Configuration Tool o con STEP 7 a partire da V12.  

Requisiti richiesti 
Per il trasferimento di un nuovo firmware su un dispositivo SCALANCE S devono essere 
soddisfatti i seguenti requisiti: 

● Si deve disporre di autorizzazioni di amministratore per il progetto.  

● Il dispositivo SCALANCE S deve essere progettato e raggiungibile con un indirizzo IP. 

La trasmissione è codificata 
Il trasferimento del firmware avviene tramite un collegamento protetto e può quindi essere 
eseguito anche dalla rete non protetta.  

Il firmware stesso è contrassegnato e codificato. In questo modo viene assicurato che sul 
dispositivo SCALANCE S possa essere caricato solo un firmware autentico. 
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Il trasferimento può essere eseguito durante il funzionamento 
Il trasferimento del firmware può essere eseguito durante il funzionamento di un dispositivo 
SCALANCE S. La comunicazione viene tuttavia interrotta per la durata dopo il caricamento 
fino al riavvio concluso automaticamente del dispositivo SCALANCE S. Un nuovo firmware 
caricato diventa attivo solo dopo questo riavvio del dispositivo SCALANCE S.  

Se il trasferimento è stato disturbato o interrotto, il dispositivo si avvia di nuovo con la 
versione di firmware precedente.  

Esecuzione del trasferimento nel Security Configuration Tool 
Selezionare SCALANCE S nell'area del contenuto del Security Configuration Tool e quindi la 
voce di menu "Trasferisci" > "Trasferisci firmware...". 

7.3 Il dispositivo SCALANCE S non si avvia correttamente 
Se l'indicatore di errore del dispositivo SCALANCE S si accende con luce rossa dopo l'avvio 
del dispositivo, è necessario dapprima ripristinare completamente il dispositivo. Premere il 
tasto di reset fino a quando l'indicatore di errore inizia a lampeggiare con luce arancione-
rossa. Successivamente il dispositivo è resettato alle impostazioni di fabbrica ed esegue un 
riavvio. Per l'esercizio produttivo è successivamente necessario caricare di nuovo la 
configurazione nel dispositivo. 

Se un riavvio non può essere eseguito per tre volte consecutive, il firmware viene resettato 
alla versione utilizzata in precedenza. Se l'indicatore di errore del dispositivo SCALANCE S 
dovesse tuttavia riaccendersi con luce rossa, il dispositivo deve essere inviato in fabbrica per 
la riparazione. 

Vedere anche 
Tasto Reset - Ripristino della configurazione all'impostazione di fabbrica  (Pagina 25) 

7.4 Il dispositivo SCALANCE S non è raggiungibile 

Cause possibili: 
● Il computer non si trova nella stessa sottorete del dispositivo SCALANCE S. 

● Il dispositivo SCALANCE S esegue attualmente un reset. 
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7.5 Il dispositivo SCALANCE S è compromesso 
 

Un dispositivo SCALANCE S è compromesso se è stato comunicato quanto segue:  

● il codice privato appartenente al certificato del server, 

● la chiave privata dell'autorità di certificazione, 

● la chiave di un gruppo VPN con il metodo di autenticazione "Preshared Key" o 

● la password di un utente. 

Codice privato noto del certificato del server  
Se la chiave privata appartenente al certificato del server è stata comunicata, il certificato del 
server sul dispositivo SCALANCE S deve essere sostituito. I nomi utente memorizzati nel 
dispositivo SCALANCE S non devono essere modificati.  

Security Configuration Tool - Procedimento: 
1. Selezionare la voce di menu "Options" > "Certificate manager...", scheda "Device 

certificates". 

2. Selezionare il certificato SSL dell'unità SCALANCE S corrispondente e selezionare nel 
menu di scelta rapida la voce "Rinnova certificato...". 

3. Inserire i parametri per il nuovo certificato SSL e confermare l'inserimento con "OK". 

4. Caricare la progettazione sull'unità SCALANCE S. 

La chiave privata dell'autorità di certificazione è conosciuta 
Se il codice privato dell'autorità di certificazione è stato comunicato, il certificato dell'autorità 
di certificazione sull'unità SCALANCE S deve essere sostituito. I nomi utente possono 
restare invariati. Tuttavia i gruppi VPN necessitano di nuovi certificati creati dalla nuova unità 
di certificazione.  

Security Configuration Tool - Procedimento: 
1. Commutare event. il progetto in modalità estesa tramite la voce di menu "Visualizza" > 

"Modalità estesa". 

2. Selezionare il gruppo VPN da modificare nell'area di navigazione. 

3. Selezionare la voce di menu "Edit" > "Properties...". 

4. Generare un nuovo certificato del gruppo VPN facendo clic nell'area "Certificato" sul 
pulsante "Nuovo..." 

5. Confermare entrambe le finestre di dialogo seguenti con "Sì" o "OK". 

6. Caricare la configurazione in tutte le unità SCALANCE S appartenenti al gruppo VPN. 
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La chiave di un gruppo VPN con il metodo di autenticazione "Preshared Key" è conosciuta 
Se la chiave di un gruppo che utilizza il metodo di autenticazione "Preshared Key" è resa 
nota, la chiave deve essere rinnovata nelle proprietà di questo gruppo VPN. Infine la nuova 
configurazione deve essere caricata in tutte le unità SCALANCE S che sono nodo del 
gruppo VPN. 

Security Configuration Tool - Procedimento: 
1. Commutare event. il progetto in modalità estesa tramite la voce di menu "Visualizza" > 

"Modalità estesa". 

2. Selezionare il gruppo VPN da modificare nell'area di navigazione. 

3. Selezionare la voce di menu "Edit" > "Properties...". 

4. Generare una nuova chiave facendo clic nell'area "Preshared Key" sul pulsante 
"Nuovo..." 

5. Confermare la seguente finestra di dialogo con "OK". 

6. Caricare la configurazione in tutte le unità SCALANCE S appartenenti al gruppo VPN. 

Password di un utente conosciuta 
Se la password di un utente dispone di autorizzazioni di amministratore relative alla 
progettazione e / o relative ad un'unità o diverse unità, il certificato del server dell'unità 
corrispondente e la password dell'utente devono essere modificati. 

Se la password di un utente al quale è assegnato il ruolo "standard", "diagnostics" o "remote 
access" è conosciuta, la password dell'utente deve essere modificata. 
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 Disegni quotati 8 
 

 

Disegno quotato per dispositivi SCALANCE S602 / S612 / S623 
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Disegno quotato per dispositivi SCALANCE S627-2M 
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 Omologazioni A 
 

 

I prodotti SIMATIC NET descritti in questo manuale operativo dispongono delle omologazioni 
riportate di seguito. 

 

 Nota 
Omologazioni riportate sulla targhetta identificativa dell'apparecchio 

Le omologazioni indicate valgono come indicate solo se sul prodotto è applicato il relativo 
contrassegno. Quale delle seguenti omologazioni sia stata assegnata al prodotto è indicata 
sulla targhetta identificativa. 

 

Omologazioni attuali in Internet 
Le omologazioni attuali per il prodotto si trovano anche nelle pagine Internet del Siemens 
Industry Online Support: 

https://support.industry.siemens.com/cs/ww/de/ps/15327/cert 
(https://support.industry.siemens.com/cs/ww/it/ps/15327/cert) 

Direttive CE 
I prodotti SIMATIC NET soddisfano i requisiti richiesti e gli obiettivi di protezione delle 
direttive CE descritte di seguito. 

Direttiva EMC (compatibilità elettromagnetica) 
I prodotti SIMATIC NET descritti in questo manuale operativo soddisfano i requisiti richiesti 
dalla direttiva UE 2004/108/CE "Compatibilità elettromagnetica" per i seguenti settori 
d'impiego: 
 
Campo d’impiego Richieste relative a 

Grado di radiodisturbi Resistenza ai disturbi Grado di protezio-
ne 

Industria EN 61000-6-4: 2007 EN 61000-6-2: 2005 IP 20 

Direttiva RoHS (Restriction of certain Hazardous Substances) 
I prodotti SIMATIC NET descritti in queste istruzioni operative soddisfano i requisiti della 
direttiva CE 2011/65/CE "Restrizione dell'uso di determinate sostanze pericolose nelle 
apparecchiature elettriche ed elettroniche": 

● Norma applicata: EN 50581:2012 

https://support.industry.siemens.com/cs/ww/it/ps/15327/cert
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 AVVERTENZA 

Possono verificarsi danni a persone e a cose 

Con l’installazione di ampliamenti che non sono omologati per i prodotti SIMATIC NET o 
per i relativi sistemi di destinazione, si possono infrangere le richieste e le norme per la 
sicurezza e la compatibilità elettromagnetica. 

Utilizzare solo gli ampliamenti omologati per il sistema. 
 

● Osservanza delle direttive di montaggio 
I dispositivi soddisfano i requisiti richiesti se in fase di installazione e di funzionamento 
vengono osservate le direttive di montaggio e le avvertenze di sicurezza descritte nella 
presente documentazione e nelle seguenti documentazioni. 

● In Internet si trova sempre la documentazione più attuale 
Le descrizioni attuali per i prodotti attualmente disponibili si trovano sempre in Internet 
all'ID articolo/alle pagine Internet qui indicate: 

– Manuale di sistema "Industrial Ethernet / PROFINET Industrial Ethernet" 

– Manuale di sistema "Industrial Ethernet / PROFINET Componenti di rete passivi" 

– Manuale di progettazione "Direttive di montaggio EMC" 

60612658 (http://support.automation.siemens.com/WW/view/it/60612658)  

● Interventi sul dispositivo 
Per proteggere il dispositivo da scariche elettrostatiche, prima di toccare il dispositivo il 
personale operativo deve scaricare la propria corrente elettrostatica. 

 
  Nota 

Il test è stato eseguito con il dispositivo e un partner di comunicazione collegato, 
anch'esso conforme alle norme indicate. 

In caso di funzionamento del dispositivo con un partner di comunicazione non conforme a 
queste norme, non è possibile garantire il rispetto dei valori corrispondenti. 

 

Dichiarazione di conformità UE 
La dichiarazione di conformità CE relativa a questi prodotti si trova nelle pagine Internet del 
Siemens Industry Online Support 
(https://support.industry.siemens.com/cs/ww/it/view/66920341). 

Avvertenze per i costruttori di macchine 
Ai sensi della direttiva macchine CE, il prodotto non è una macchina. Per questo motivo, per 
questo prodotto non esiste una dichiarazione di conformità riferita alla direttiva CE macchine 
Se il prodotto fa parte dell'equipaggiamento di una macchina, il costruttore della macchina 
deve includerlo nella dichiarazione di conformità. 

http://support.automation.siemens.com/WW/view/it/60612658
https://support.industry.siemens.com/cs/ww/it/view/66920341
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Omologazione cULus Information Technology Equipment 
cULus Listed I. T. E. 

Underwriters Laboratories Inc. secondo 

● UL 60950-1 (Information Technology Equipment) 

● CSA C22.2 No. 60950-1-03 

N. Report E115352 

● UL 508 

● CSA C22.2 No. 142-M1987 

N. Report E85972 

Omologazione cULus Hazardous Location 
cULus Listed I. T. E. FOR HAZ. LOC. 

Underwriters Laboratories Inc. secondo 

● UL 60950-1 (Information Technology Equipment) 

● ANSI/ISA 12.12.01-2007 

● CSA C22.2 No. 213-M1987 

Approved for use in 
Cl. 1, Div. 2, GP A, B, C, D T4 
Cl. 1, Zone 2, GP IIC T4 

N. Report E240480 

FM 
Il prodotto soddisfa i requisiti delle norme: 

● Factory Mutual Approval Standard Class Number 3611 

● FM Hazardous (Classified) Location Electrical Equipment: 
Non Incendive / Class I / Division 2 / Groups A,B,C,D / T4 e 
Non Incendive / Class I / Zone 2 / Group IIC / T4 
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ATEX (direttiva per protezione contro esplosioni) 
 

 AVVERTENZA 

Nell’impiego di prodotti SIMATIC NET nell’area a pericolo di esplosione 2, rispettare 
assolutamente le corrispondenti condizioni particolari nel documento: 

"SIMATIC NET Product Information Use of subasseblies/modules in a Zone 2 Hazardous 
Area". 

Questo documento si trova 
• nel supporto dati compreso nella fornitura di alcuni dispositivi. 
• alle pagine Internet del Siemens Industry Online Support 

(https://support.industry.siemens.com/cs/it/it). 

Come termine di ricerca inserire il numero di identificazione del documento "C234". 
 

I prodotti SIMATIC NET soddisfano i requisiti richiesti dalla norma CE:94/9/CE "Dispositivi e 
sistemi di protezione per l'utilizzo conforme in aree con pericolo di esplosione". 

Classificazione ATEX: 

II 3 G Ex nA IIC T4 Gc 

KEMA 07ATEX0145 X 

I prodotti soddisfano i requisiti delle norme: 

● EN 60079-15 (Electrical apparatus for potentially explosive atmospheres; Type of 
protection "n") 

● EN 60079-0 (atmosfere esplosive - Parte 0: Dispositivi - requisiti richiesti generali) 

Le stesure attuali delle norme sono riportate nella dichiarazione di conformità CE. 

IECEx 
I prodotti SIMATIC NET soddisfano i requisiti richiesti riguardanti la protezione da esplosione 
secondo IECEx. 

Classificazione IECEx: 

Ex nA IIC T4 Gc 

DEK 14.0025X 

I prodotti soddisfano i requisiti delle norme: 

● IEC 60079-15 (atmosfere esplosive - Parte 15: Protezione del dispositivo attraverso 
classe di protezione antideflagrante "n") 

● IEC 60079-0 (atmosfere esplosive - Parte 0: Dispositivi - requisiti richiesti generali) 

Le stesure attuali delle norme sono riportate nella dichiarazione di conformità CE. 

RCM 
Il prodotto soddisfa le richieste della norma AS/NZS 2064 (Class A). 

https://support.industry.siemens.com/cs/it/it
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MTBF (40 °C) 
● SCALANCE S602/S612: 54,56 a 

● SCALANCE S623: 52,42 a 

● SCALANCE S627-2M: 38,13 a 

Marchio per l'unione doganale euroasiatica 
EAC (Eurasian Conformity) 

Unione doganale euroasiatica per Russia, Bielorussia e Kazakistan 

Dichiarazione di conformità secondo le prescrizioni tecniche dell'unione doganale (TR CU) 
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